MathWorlds Student Worksheet 1: Representing motion with position/time graphs

1.
Open lifts-graphs.mw. 

The windows (ie Controls and Numeric Display) can be found under the Window Menu.
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 in the Controls window to animate (make the lift move).  Note the changing values on the Numeric Display. 

The animation can also be observed by stepping through. 

Clicking the little yellow feet [image: image2.png]2
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on the right of the Controls window will step through the animation one step at a time.
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. 

Step through the animation recording the values from the Numeric Display at each step ie

	Position 
	Time

	0.00
	0.00

	1.00
	2.00

	2.00
	4.00

	
	

	
	

	
	


Use your table to plot the points on the graph of Position against time (given on the next page).
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Click the challenge (Chal) button in the top right hand corner for the next challenge.

For each challenge, step through the animation, record the values and plot the graph on the axes above.

2.              Open intro.mw 

You will see that the lift leaves marks. This is because the Marking is ON in the Actor window (found in the Window menu). The lift leaves a mark every step. Animate as many times as you need until you are confident that you understand see what is happening. Remember to click on rewind each time.
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	a. On what floor does the lift start its journey?

b. On which interval is the lift going the fastest? (i.e. when are the marks most far apart?) 

c. How many floors does the lift travel in 1 second? ( ie. how fast is it going ) for each part of the trip (on each interval)? HINT: look at the Marks.

d. What can you say about the graph? (i.e what is different about the two segments of the graph?)

Click the Challenge [Chal] button in the right hand corner of the window. Repeat the questions a – d above for each challenge.

	


MathWorlds Student Worksheet 2: Linking Symbolic Representation and Graphical Representation

Open the file symbolic.mw  The Algebra window (and Controls, Actor Info and Numeric Display) can be found under the Window Menu. Rememebr to rewind after each animation.

1. Run the animation to compare the motion of the blue (B) lift with the movement of the red (A) lift. We want to make the motion of the blue (B) lift match the motion of the red(A) lift.

2. In the Algebra Window, fill in the Initial Value (i.e. the floor the lift starts on), the Slope of the linear segment (i.e. your first guess at the number of floors the lift needs to travel in 1 second) and the End Time (i.e. how long the lift needs to travel)  for your algebraically defined function. 

3. Repeat the editing as needed till the movement of the red (A) lift and the blue (B) match exactly, using Marks and Stepping as needed.

4. Write your formula for blue (B) lift’s Position function and print out a copy of the graph. 

5. Write down a table of values by stepping through the animation and recording the values in the Numeric Display. Mark these values on the graph.

6. Find the differences between successive floor values. How is the difference connected to the number of floors per seconds the lift travels?

Repeat steps 1 – 6 for each of the Challenges [Chal] at both levels

Open the file graphically.mw  The graph can be changed by dragging the hotspots. . Change the time interval (domain) using the hotspot on the horizontal axis; change the height of the lift using the hotspot at the end of the graph line; change the starting position using the hotspot on the vertical axis.

5. We want to make the red (A) lift, starting from the first floor, catch up to the blue (B) lift (don’t change lift B) on the 6th floor then continue up, stopping at the same Time as the blue (B) by changing the graph for the red (A) lift. (Make use of the numeric display and Step animation)

a. Where does the red (A) lift end its journey? 

b. Print out the Position graph. 

c. Write the linear function for the blue (B) lift.

6. Use graphically.mw to illustrate the following situation. You will need to use the Algebra window to manipulate graph B. 

Anita and Becky are on the ground floor (Anita is in the red lift) and Anita will go to the 10th floor in 10 seconds to deliver a pizza. Becky wants to get there 2 minutes ahead of Anita to open the door of the apartment. What is Becky’s speed?

7. Suppose Becky went at the same speed for 10 seconds instead of 8 seconds.

a. How far above the 10th floor would she be at the end of her trip?

b. Would the door open so that she would be able to get off of the lift? Explain.

8. Suppose Anita and Becky were in glass lifts on the outside of a building. If the red lift (A)i.e. Anita, started on the 12th  floor and went down to the ground floor at 3 fl/sec, and the blue (B) lift i.e. Becky,  went up from the 2nd floor at 1 fl/sec and stopped at the same time, would Anita and Becky be able to wave to each other as they go by, and if so, where?

Extension Question: 

The red (A) lift i.e. Anita, starts on the 2nd floor and travels at 1 fl/sec, while the blue (B) lift i.e. Becky,  starts on the −3rd  floor and travels at an unknown Velocity, but catches up with the red (A) lift i.e. Anita,  on the 6th  floor. How many seconds must the blue (B) lift i.e. Becky, travel to be 4 floors above the red (A) lift i.e. Anita ?

MathWorlds Student Worksheet 3: Average Rate of Change

Open the file velocity.mw  

1. Starting at the ground floor, get to the 8th floor with two different Velocities—slow for the first part of the journey, and then fast for the rest of the journey. 

Do this by adding a second Velocity segment and then adjust the two Velocity graph segments’ width and height so that the lift travels slowly for the first part of its journey to the 8th floor, and quickly for the second part of the journey. Write down a description of each velocity segment (More than one answer is possible) 

2. Step through the animation and record, in a table, the values from the Numeric Display.

Print out a copy of the graph.

3. Uncheck the Snap-to-Grid in the View menu. Starting at the 3rd floor, get to the 11th floor with two different Velocities—fast for the first part of the journey, and then slow for the rest of the journey. Write down a description of each velocity segment (More than one answer is possible) 

Open the file average.mw  

4. Add a green position segment so that the green (B) lift reaches the 14th floor at the same time as the red (A) lift.
5. Switch to the Velocity graph. Write down the velocity of the red (A) lift and the two velocities of the segments for the green (B) lift.

6. Remove all segments except for one red (A) segment  and switch to the position graph.

Prepare a position graph, by adding and adjusting position segments, which causes the lift to begin on the 4th floor, travels to the 10th floor, stopping at each floor for 2 seconds and returns to the ground floor at 2 floors per second. 

7. What single velocity segment would take the lift to the 10th floor in the same time?

	8.           Here is a position graph for a four-part trip.

a. Make up a short story that fits the trip.

b. Sketch a four-part velocity graph that matches the position graph and then check your conjecture by running the position graph. 

c. Revise your velocity graph's fourth part in two ways so that the lift returns to where it had stopped previously - first by changing only the length of the fourth part and then by changing only the velocity.

d. How long will the lift take to make this trip?

e. What single velocity segment would take the lift to the 8th floor in the same time as this four-part trip?
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MathWorlds Student Worksheet  4: Different Contexts 

Open the file space.mw

A space craft needs to dock with the space station to refuel.

Both the space craft and the space station are traveling in the same direction, but with different speeds and starting at different distances away from the mothership.

1. How far are they from the mothership at the start?

2. How fast are they traveling?

3. Will the space craft ever catch up to the space station?

4. How far away from the mothership will they be when the space craft catches up to the space station?

5. How long will it take for the space craft to catch up to the space station?

Suppose the spaceship speeds up.

6. How fast does it need to go to catch up with the space station in 20 seconds?

7. How far away from the mothership will they be when the space craft catches up to the space station?

Open the file marathon.mw

Frog and clown are runners in a marathon. Create a graph that describes their race eg. Sometimes clown is moving faster, other times frog is moving faster; sometimes they are going uphill and sometimes downhill etc.

Write a description of the race that matches the graph you have created.

MathWorlds Student Worksheet  5 

Open the file velocity.mw  

1. Change the Velocity graph so that the lift gets to the 12th floor with two different Velocities, quickly for the first part of the journey and slowly for the second part. The entire journey is to be completed in 5 seconds. What is the Total Area between the new Velocity segments and the Time-axis?

2. Suppose that you need to get to the 12th floor with a two-part journey, but the only two Velocities you can use are 2 fl/sec and 1 fl/sec. How many ways can it be done with the faster part first and using only whole-number Times?

3. Make a two-part Velocity graph that gets the lift to the 12th floor, and then back down to the 3rd floor. Printout a copy of the graph.

4. We now want the lift to stop to pick up passengers. Make a multiple-part Velocity graph so that the lift goes up to a certain floor, stops to pick up a passenger, goes down a few floors, stops to pick up another passenger, goes up slowly and stops at some floor to drop them off, and then returns to the ground floor quickly.

Extension Question:

Pizza Deliveries: Suppose that you have some pizzas to deliver. Start on the ground floor, go up to two different floors, stopping at each floor for 2 seconds to drop off the pizzas, and then returning to the ground floor.

Open the file velocity2.mw  

5. Describe the journey in words, and write the Total Distance Traveled as an equation (include units).

6. Here is an equation that describes the journey of a lift: floors = 2 fl/sec * 4 seconds + 0 fl/sec * 2 seconds + −1 fl/sec * 3 seconds + 4 floors

Describe the journey in words. Make and run the journey to confirm your written description.

Extension Question:

Open the file velocity.mw  

Suppose the red (A) started on the 8th floor and then traveled an unknown Velocity of V1 fl/sec for an unknown Duration of T1 seconds. The green (B) lift started on the 2nd floor and then traveled an unknown Velocity of V2 fl/sec for T2 seconds. Determine possible values for V1, T1 and V2, T2 so that both lifts end up on the 12th floor. How many possible answers are there? Use whole integers only!

Open the file equations.mw  

7. The lift started in the basement on the −2nd floor and went at 2 fl/sec for 3 seconds before traveling at an unknown constant Velocity for 3 seconds, then traveling at −2 fl/sec for 2 seconds, and finally traveling at 3 fl/sec for 3 seconds, ending on the 18th floor. 

(a) Write an equation that describes the mystery trip, 

(b) solve the equation to determine the unknown Velocity.

8. The lift moves according to a 4-segment Velocity graph, including zero Velocity between 5 and 6 seconds. If the Total Distance Traveled by the lift is 9 floors, determine the “missing” Velocity. Make sure you include units in your first equation and your answer.

9. Starting on the −3rd floor, the lift traveled at 3 fl/sec for 2 seconds, then at 5 fl/sec for 3 seconds, then at V fl/sec for T seconds. If it took a Total Time of 9 seconds for the lift to reach the 10th floor, determine the unknown Time and Velocity.

Open the file simultaneous1.mw  

10. Adjust the graphs so that the lifts meet at the 5th floor. At what time does this occur?

Print out a copy the graphs. Write down the equations for each lift. Copy an appropriate part of the table for each lift.

11. Create a situation where one lift starts at the 3rd floor and travels to the 10th floor whilst the other lift starts at the 10th floor and travels to the ground floor with the second lift reaching the ground floor before the first lift reaches the 10th floor. Where do the lifts pass each other? When does this occur?

Print out a copy the graphs. Write down the equations for each lift. Copy an appropriate part of the table for each lift.

� Adapted from Stylianou, D., & Kaput, J. (2002).   "Understanding complexity linking phenomena to representations." Paper submitted for presentation at the Annual Conference of the North American Chapter of the International Group for the Psychology of Mathematics Education, October 26-29, 2002, Athens, GA
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RITEMATHS – Real world problems and Information Technology Enhancing Mathematics . RITEMATHS is a project of the University of Melbourne and the University of Ballarat and schools.

This material has been adapted from the curriculum materials developed by the SimCalc project and available at http://tango.mth.umassd.edu/
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